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Plaintiff Microsoft Corporation (“Microsoft”), for its Complaint against Defendants
Corel Corporation and Corel Inc. (collectively “Corel” when it is not necessary to distinguish
between the two entities), alleges as follows:

INTRODUCTION

1. Microsoft brings this action to protect its rights and investment in its innovations
embodied in utility U.S. Patent Nos. 8,255,828 (“the 828 patent”), 7,703,036 (“the 036 patent”),
7,047,501 (“the ’501 patent”), 5,715,415 (“the *415 patent™), 5,510,980 (“the 980 patent’’) and
design U.S. Patent Nos. D550,237 (“the D’237 patent”), D554,140 (“the D’140 patent”),
D564,532 (“the D’532 patent”), and D570,865 (“the D’865 patent,” collectively “the Microsoft
Asserted Patents”), copied by Corel into its infringing products.

2. The Microsoft Asserted Patents are directed to, among other things, graphic user
interfaces used in productivity software applications, such as Microsoft Office. Microsoft has
given its interfaces, including menus and toolbars, a distinctive look and feel. The Microsoft
interfaces are recognizable and enjoy substantial goodwill. For example, Microsoft has introduced
and publicized the Microsoft Ribbon—a horizontal display of easily accessible and logically
grouped controls whose layout can be dynamically adjusted based on the screen size or object of
the program.

3. Corel has copied the look and feel of the Microsoft interfaces in its accused
products. Among many examples, Help for WordPerfect X7 suggests that the user “simulate the

Microsoft Word workspace until you are accustomed to work in WordPerfect”:

1 COMPLAINT FOR PATENT INFRINGEMENT
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) WordPerfect Help
&« = K & B

Back Font Print Options

Contents| Index| Search|

Type in the word(s) to search for:

miciosoft -

Selecttopic: Found: 49
Title Locat +
Reference: Moving between Microsoft W.. Word
Opening and saving documents Word
Sharing documents with Microsoft Word u.. Word
Simulating the Microsoft Word workspace  Word
WaordPerfect compatibility with Microsoft.. Word
Using macros Word
Und. ding OLE Automati Word
Converting batches of Microsoft Word file.. Word
Import formats forword-processor and tex.. Word
Using Microsoft SharePointwith WordPer.. Word
Comparing Microsoft Word and WordPer.. Word
Using Microsoft Word shortcut keys inW... Word| _
Using Microsoft Outlook address book wi.. Word =
Using OLE Automation Word
Export formats for word-processor andte..  Word
Integrating with Microsoft Visual Basic for .. Word
Reviewing documents Word
Glossary Word
Copying and pasting text Word
Changing the workspace Word

Impor formats for spreadsheets and data.. Word
Working with documents in a Web browser Word
Creating redacted versions of documents  Word
Compatibility with Microsoft Word Word
Import and export file formats for WordPer.. Word

Expon formats for spreadsheets Word
Using a document management system .. Word
Routing documents Word
Using address books in merges Word
WordPerfect compatibility FAQ Word
Creating and modifying envelopes Word
Creating labels Word
Associating merge files Word
Frequently asked questions Word
Converting multiple files Word

< 1 »

[ search previous results
[¥] Match similar words

| |Searchtitles only

Resources
-
oo ompatibility with QiiMgelelji Word : WordPerfect th e Word
Simulating the [JIdli Word workspace
On this page:

= Towork in the Word workspace
« Todisplay the [EERL Word toolbar in WordPerfect
« To display the Compatibility toolbar

Simulating the [[E1 i Word workspace

If you recently switched from Word to WordPerfect, you may not be familiar with the WordPerfect
workspace. While there are many similarities between the two applications, you may find it easier to
simulate the Word workspace until you are accustomed to working in WordPerfect. What the
Word workspace does is position the WordPerfect features, including toolbars and menu items,
where you would find the equivalent feature in JIETERL Word. It also applies | Word keyboard
shortcuts to WordPerfect features, allowing you to quickly find the tools you need to create documents in
WordPerfect.

For more information about [I[ETESEL Word features and their equivalents in WordPerfect, see Comparing
| Word and WordPerfect features

If you prefer to work in the WordPerfect workspace, but you want to access the most common WordPerfect

features using IIEEEEL Word buttons and icons, you can display the [T Word toolbar. In addition,
you can display the [[[TEET T Word Compatibility toolbar, which gives you immediate access to features,

such as saving documents to [JIM{+=k]j Word and publishing to PDF.
The following illustration shows the Compatibility toolbar: & &2 & & & ™.

To work in the [T Word workspace *

1. Click Tools » Workspace manager.
2. Enable the [[[E{11=1 Word mode option.

To display the [[[51- 1. Word toolbar in WordPerfect *

1. Click View » Toolbars

2. Enable one of the following check boxes:
« [IEEEET Word 97
« [T Word 2002

To display the Compatibility toolbar *

1. Click View » Toolbars
2. Enable the Compatibility check box.

000

Copyright 2014 Corel Corporation. All rights reserved.
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4. WordPerfect X7 offers an option to use it in the “Microsoft Word mode”:
kY WordPerfect X7 - [Document1 (unmadified)] (= [@] =]
L! File Edit View Insert Format Table Tools Window Help
[Rale=g) - s ey MM MR A - WA WAL —RFAt-Ad:: IS ) | - 2~ S | 7=
: B 7 U- x* ®-E-%£- -
Times New R - 12 -
fmes New foman Bold Italic Superscript <None> IZI‘ QuickFind Previous -

11

0

Workspace Manager

Choose the WordPerfect mode that you wantto work in

-._:_.-WordPerfect Mode

(@) Microsoft Word Made
-_:_-WordPerfectC\assm Mode (version 5.7}
() WordPerfect Legal Mode

The mode you choose changes the look of, and options found in, the WordPerfectworkspace. To
change the workspace mode during a WordPerfect session, click Tools = Workspace Manager.

[ Show at startup gL l I Eapeel ] I hlelp

‘ i >
[ Documentl BMEseS < Count » Insert Pg1Llnl"Posl” S
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5. While in the Microsoft Word mode, WordPerfect X7 simulates the Microsoft Word

workspace by copying the look and feel of the Microsoft user interface:

kY wordperfect X7 - [Document1 (unmodified)] (o= ][=]

LEBE

aY File Edit View Insert Format Tools Table Window Help
. og” [z B £
=
LB - Sl BY| 5 ¢-

- 2 - E - AS -
Times New Roman - |12 - B 1 - b ) MCMISRE <None= IZI
Bold Italic Superscript

14
1 2 3 5 3

%,gﬁg% 5t S 3 S Y S Y S Y 3 Y S S

QuickFind Previous -

-

WordPerfect

Start -
Write a Draft

SetUp the Document

m

Typing

Formatting

Add Visual Elements
Editand Proofread

Finish

Compatibility %]
il 4 B %=

Tip #® 2

Create a wide variety of
documents quickly and easily
with WordPerfect

ml=r

More Help on ‘ = R

ocument [§a8 < Count = nsert g1lLlnl"Pos1" B
D ik B[Hae & C I Pglln1"Pos1 =
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6. As another example, Help for Quattro Pro X7 suggests that the user “simulate the

Microsoft Excel workspace ... until you are accustomed to working in Quattro Pro™:

2 Quattro Pro Help (o= =]
<& & Br [¢]
Back Font Print Options  Resources

p
| Contents| Index| Search 00 Microsoft - Quattro Pro compatibility with y
Type in the word(s) to search for. Excel : Simulating the [[[d{e=)j| Excel workspace \

microsoft - )
— On this page:
- Towork in the Excel workspace
Selecttopic: Found: 33 - To display the Compatibility toolbar
Title Location + To switch to the [f¥ieeei Excel naming convention for spreadsheet tabs
Reference: Moving between Microsoft Exc... Quattro Prok
Opening and saving files QuatroProt | | | Simulating the [[Tan 4 Excel workspace
Sharing spreadsheets with Microsoft Excel... Quattro Prok
Simulating the Microsoft Excel workspace  Quattro ProF If you recently switched from Excel to Quattro Pro, you may not be familiar with the
Quatiro Pro compatibility with Microsoft Ex . Quatiro Pro F Quattro Pro workspace. While there are many similarities between the two applications, you
0 Fro comp ty . may find it easier to simulate the [[[H{0s00 Excel workspace. What the Eﬁﬁ Excel
Opening Microsoft Excel templates Quattro Pro F workspace does is position the Quattro Pro features until you are accustomed to working in
Creating the equivalent of a Microsoft Exce.. Quattro Pro Quattro Pro, including toolbars and menus items, where you would find the equivalent
Using macros Quattro Pro F feature in Excel. It also automatically saves to the Excel format, displays

sheets as numbers, and applies Excel keyboard shoricuts fo Quatiro Pro features,

Comparing Microsoft Excel and Quattro Pr... Quattro Pro © allowing you to quickly find the tools you need to create Excel compatible files in

Changing the workspace Quattro Pro k Quattro Pro.

Converting currency formats Quattre Pro b In addition, you can display the Compatibility toolbar, which gives you immediate access to
Reference: Managing flles and data Quattro Pro F tools such as saving documents fo il Excel and publishing to HTML.

Reference: Using OLE automation Quatiro Pro F You can also change spreadsheet tabs in a Quattro Pro notebook to adopt the
Quatiro Pro compatibility FAQ Quattro Pro k- Excel spreadsheet naming convention.

Creating VBA macros Quattro Pro H

Reference: Using macros Quattro Pro H

Renaming spreadsheets Quattro Pro k =

Compatibility with Microsoft Excel Quattro Pro H oo s M Excel workspace =
Managing and sharing graphics Quattro Pro H 1. Click Tools » Settings.

Debugging and editing a VBA macro Quattro Pro H 2. Click Workspace.

Glossary Quattro Pro 3. Enable the check box beside the [[[8:rs Excel workspace in the available

Changing compatibility options Quattro Pro H workspaces list.

Using macros Quattro Pro H

Publishing to PDF Quatiro Pro H

Welcome to Quattro Pro Help Quattro Pro H To display the Compatibility toolbar a
Creating CrossTab reports by using ODB...  Quattro Prok

Using shortcut keys Quattro Pro H 1. Click View » Toolbars.

Waorking with spreadsheet functions Quattro Pro H 2. Enable the Compatibility toolbar check box in the Toolbar list.

Quattro Pro Functions Equivalents Quattro Pro H

Opening and saving files Quattro Pro H

Changing currency and punctualion settings  Quatiro Pro F To switch to the [[[T37:50.: Excel naming convention for spreadsheet tabs *
Using compatibility features Quattro Pro H

1. Click Tools b Settings.
2.In the list of categories, expand Workspace » Application, and click Compatibility.
3. Inthe Sheet tab display area, enable the Display as numbers check box.

Q0O

Using the PerfectScriptclassto change a.. Quattro Prok

< | 101 | »

["|search previous results

[ Match similar words
l:‘ Search fitles only Copyright 2014 Corel Corporation. All rights reserved.
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7. Quattro Pro X7 offers the option to use it in the Microsoft Excel mode:
EQuattro Pro X7 - [C\Users\mua\Documents\Notebk1.QPW (unmodified)] = ===
E; File Edit View [Insert Format Tools Window Help _ &= *
Arial ~ 10 ~BIU A ‘[ﬂq- 5;;5;5-%v|@
S I (T ey (IO m
DE2REaas el - -lvu -pRlpgEmE 4 - aBE Xklel
(a1 v @
A B C D E F G H J K -
1 3
2
3
4
5
6
7 ——
8 EWorkspace Manager 23 |
190 Choose the Quatiro Pro mode that you want to work in
1; (") Quatiro Pro Mode
13 (@ Microsoft Excel Mode
14 () Lotus 1-2-3 Mode
15
16
17 The mode you choose changes the look of, and options found in, the Quattro Pro workspace. To
18 change the workspace mode during a Quattro Pro session. click Tools » Workspace Manager.
19
20
21 ok |[ cacel [ el
2 || show at startup P
23
a4

8. While in the Microsoft Excel Mode, Quattro Pro X7 simulates the Microsoft Excel

workspace by copying the look and feel of the Microsoft Excel user interface:

@ Quattro Pro X7 - [CA\Users\mua‘\Documents\Notebkl.QPW (unmodified)] |E||E||E|
; File Edit View [Insert Format Tools Data Window Help = | &[] =
Deraa aldry o -z -kl A
Arial +v1wu ~BIJIU me 2k [ormal v |l @y U v av |@

[aa v @

lml »

0000 | = |00 N P DD P —
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9. Corel’s advertising makes the copied Microsoft interfaces one of the central selling
points of Corel’s products: “With a familiar Ribbon-style interface, Corel® Office looks like the
office software you’re used to, making it easy to get to work right away.”

http://www.wordperfect.com/us/product/corel-office-software/

Built-in PDF creation
Save your files in PDF format directly from Corel Office. No need
to buy extra software! -

Corel Write - [\

g
-
/EC

@

) -
ili 5 Home Ingert Page L. t Tools View
Familiar workspace i -

Pick your preferred workspace so you instantly feel comfortable @ oo t : I N Chart [ Ecit neader || [Ti] Frame
Lj f
w

and start working productively. Choose between wide, ribbon- Jawrite £X || [2) Edit footer || "] Callout
Tabile Picture -

style toolbars or familiar regular-sized toolbars. | ITobject || [#) Page Number || [£3] Text Box
Multilingual workspace WEHOOAS R A
Change menus, toolbars and help topics to multiple languages at
the click of a button. lm —

w u Ve K

Basic Shape

Customizable color scheme IO00CC ANDO
Have fun changing the background color of your workspace, 5 OBC
pages and toolbars to suit your mood. L J & )
Built-in Help 1

Get help with the click of a button so you can master Corel
Office and get your work done quickly.

http://www.wordperfect.com/us/product/corel-office-
software/?showdialog=freeTrial&currency=en-US#tab3

10. Corel has thus deliberately capitalized on the ready familiarity and rich
functionality of the Microsoft interfaces and has taken advantage of Microsoft’s years of effort and
hundreds of millions of dollars of investment in those interfaces.

11. Microsoft has warned Corel on multiple occasions regarding its blatant copying of
the Microsoft interfaces. Despite those warnings, Corel has continued its infringement unabated.

Corel’s own actions are thus directly responsible for this lawsuit.

7 COMPLAINT FOR PATENT INFRINGEMENT
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PARTIES

12.  Microsoft Corporation is a Washington corporation with a principal place of
business at One Microsoft Way, Redmond, Washington 98052-6399.

13. On information and belief, Corel Corporation is a Canadian corporation with a
principal place of business at 1600 Carling Avenue Ottawa, Ontario, Canada K1Z 8R7. Corel
Corporation is in the business of making, selling, offering to sell, importing, licensing, and/or
distributing software.

14. On information and belief, Corel Inc. is a Delaware corporation that has a principal
place of business at 385 Ravendale Drive, Mountain View, California 94043 and states its address
as 1600 Carling Avenue Ottawa, Ontario, Canada K1Z 8R7. Corel Inc. is in the business of
making, selling, offering to sell, importing, licensing, distributing software and/or providing
customer support or training.

JURISDICTION AND VENUE

15. This is an action for patent infringement, over which this Court has subject matter
jurisdiction pursuant to 28 U.S.C. §§ 1331 and 1338(a).

16. This Court has personal jurisdiction over Corel Corporation for at least the
following reasons: (i) Corel Corporation has committed acts of patent infringement and/or
contributed to or induced acts of patent infringement by others in this District and continues to do
s0; (i1) Corel Corporation regularly does business or solicits business, engages in other persistent
courses of conduct, and/or derives substantial revenue from products and/or services provided to
individuals in this District and in this State; and (iii) Corel Corporation has purposefully
established substantial, systematic and continuous contacts with this District and expects or should
reasonably expect to be subjected to this Court’s jurisdiction.

17. This Court has personal jurisdiction over Corel Inc. for at least the following
reasons: (i) Corel Inc. has committed acts of patent infringement and/or contributed to or induced
acts of patent infringement by others in this District and continues to do so; (ii) Corel Inc.
regularly does business or solicits business, engages in other persistent courses of conduct, and/or
derives substantial revenue from products and/or services provided to individuals in this District

8 COMPLAINT FOR PATENT INFRINGEMENT
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and in this State; (iii) Corel Inc. has purposefully established substantial, systematic and
continuous contacts with this District and expects or should reasonably expect to be subjected to
this Court’s jurisdiction; and (iv) Corel Inc. has designated an agent for service of process in the
State of California.

18.  Venue is proper in this judicial District pursuant to 28 U.S.C. §§ 1391 (b)-(c) and
1400(b) because Corel does business in the State of California and in this District, has committed
acts of infringement in this State and in this District, is subject to personal jurisdiction in this
District, and a substantial part of the events or omissions giving rise to this claim has occurred in
this District.

INTRADISTRICT ASSIGNMENT

19.  Pursuant to Civil L.R. 3-2(c), this case is appropriate for assignment on a district-

wide basis because this is an Intellectual Property Action.
FACTUAL BACKGROUND

A. Microsoft and Corel

20.  Microsoft is a technology company whose mission is to empower every person and
every organization on the planet to achieve more. Founded in 1975, Microsoft operates worldwide
and has offices in more than 100 countries. Microsoft develops, licenses, and supports a wide
range of software products, services, and devices that deliver new opportunities, greater
convenience, and enhanced value to people’s lives. Microsoft offers an array of services to
consumers and businesses. Microsoft’s products include the Windows operating system and
Microsoft Office, among many others.

21. Corel Corporation is a Canadian corporation founded in 1985. Corel initially sold
CorelDRAW, a graphics editor. Over the following decades, Corel acquired more editing
programs and a variety of other software. In 1996, Corel acquired from Novell Inc. the
WordPerfect word-processor, Quattro Pro spreadsheet (originally developed by Borland), and the
PerfectOffice application suite of productivity software. In 2004, Corel purchased Jasc Software,

including its graphics editor Paint Shop Pro. In 2006, Corel acquired Ulead, including its digital

9 COMPLAINT FOR PATENT INFRINGEMENT
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video editor VideoStudio. On information and belief, Corel licensed the Corel Home Office from
a vendor.

B. The Microsoft Asserted Patents

22.  The invention of Microsoft’s 828 patent is related to one aspect of the Microsoft
Ribbon. The invention allows the computer to display controls logically grouped by tabs, and to
adjust the layout based on the size of the screen.

23.  The invention of Microsoft’s *036 patent focuses on another aspect of the
Microsoft Ribbon. Editing certain objects within a program, for example a picture or a table, may
require access to numerous features specific to that type of editing. The invention automatically
makes controls particular to that object visibly available while the user is working on it.

24. Commands on a graphic user interface may be contained in (i) menus which
typically display commands through words and require the user to open the right drop-down
menu, find and select the needed menu item, or (ii) in toolbars, which display commands through
icons and make them accessible with one click, but may require more screen space. The invention
of Microsoft’s 501 patent allows users to customize command organization by letting the user
drag and drop commands anywhere the user chooses.

25.  Users often welcome helpful instructions or suggestions while working in an
application. The invention of Microsoft’s 415 patent conveniently makes the Help pane part of
the active application window for easy access and learning without disrupting the application
focus.

26. Spreadsheet programs, such as Microsoft Excel, allow users to perform calculations
by using functions—pre-written formulas that perform operations on the data in the spreadsheet.
Using a function may require the user to go through several steps of manually selecting the cells
with data and entering the appropriate functions. To simplify and speed up this process, the
invention of Microsoft’s 980 patent automatically searches the cells surrounding a cell containing
a sum function and performs the function on appropriate data.

217. The D°237, D’140, D’532, and D’865 design patents cover distinctive ornamental
designs for parts of Microsoft user interfaces, including the Microsoft Ribbon.

10 COMPLAINT FOR PATENT INFRINGEMENT
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28. Microsoft owns all rights, titles, and interests in and to the Microsoft Asserted
Patents, including the exclusive right to bring suit with respect to any past, present, and future
infringement.

29.  Each of the Microsoft Asserted Patents is valid and enforceable.

C. Corel’s Knowledge of the Microsoft Asserted Patents

1. Knowledge of the Microsoft Ribbon patents

30. The Microsoft Asserted ’828, ’036, D’237, D’140, D’532, and D’865 Patents relate
to the Microsoft Ribbon technology and design.

31. On October 8, 2009, in Redmond, WA, several members of Microsoft management
met with Jimi Duff, Corel’s Microsoft Alliance manager; and Graham Brown, Corel’s Chief
Technical Officer, who joined by teleconference. During the meeting Microsoft raised its
concerns regarding potential violation of Microsoft’s intellectual property rights by Corel’s
unlicensed use of the Microsoft Ribbon technology and design in the Corel Home Office.

32.  In November 2009, Microsoft spoke with Corel about the same issues again. Four
individuals from Corel participated by telephone, including Corel’s in-house counsel and Vice-
President of Engineering. Microsoft reiterated its concerns regarding Corel’s violation of
Microsoft’s patent rights related to the Microsoft Ribbon and the need for Corel to license the
patents if Corel wanted to use the Microsoft technology.

33.  In February 2010, Microsoft contacted Eleanor Lacy, Corel’s new General
Counsel. Microsoft requested an introduction to the vendor that had developed and was licensing
Corel Home Office to Corel, so that Microsoft could discuss intellectual property issues and the
Windows Ribbon Framework opportunity with the vendor.

34.  In March 2010, Microsoft reached out to Eleanor Lacy again, but received no
response.

35.  After Microsoft repeatedly contacted Corel, including Corel’s technology officers
and in-house counsel, about potential infringement of the Microsoft patent rights, on information

and belief, Corel reviewed Microsoft’s related patents and applications.

11 COMPLAINT FOR PATENT INFRINGEMENT
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36. On information and belief, Corel was aware that Microsoft’s licensing program for
the Microsoft Office User Interface contained a specific exclusion for competitors’ use of that

interface:

There's only one limitation: if you are building a program which directly competes with Word, Excel, PowerPoint,
Outlook, or Access (the Microsoft applications with the new Ul), you can't obtain the royalty-free license.

Why this exclusion?

Microsoft spent hundreds of millions of dollars on the research, design, and development of the new Office user
interface.

We're allowing developers to license this intellectual property and take advantage of these advances in user
interface design without any fee whatsoever.

But we want to preserve the innovation for Microsoft's productivity applications that are already using the new
UL

http://blogs.msdn.com/b/jensenh/archive/2006/11/21/licensing-the-2007-microsoft-office-user-
interface.aspx. Information about the terms of this licensing program was included with Microsoft
products and was publicly available since at least 2006. On information and belief, since at least
2006, Corel knew of this policy and this exclusion and knew that Corel needed a license to the
patents related to Microsoft interfaces if Corel wanted to use those interfaces in its products.

37. On information and belief, Corel was therefore aware, prior to the filing of this
lawsuit, of at least the 828, 036, D°237, D140, D532, and D’865 Patents that relate to the
Microsoft Ribbon technology and design. Alternatively, Corel was at least willfully blind as to the
existence of these patents.

2. Knowledge of Microsoft’s Patent Portfolio

38.  Corel is a competitor of Microsoft in the market for productivity applications,
including word processors, spreadsheets, and presentation programs.

39. On information and belief, Corel possesses the expertise required to understand the
scope of inventions claimed in the Microsoft Asserted Patents and patents related to graphic user
interfaces.

40.  On information and belief, Corel has followed Microsoft’s patent portfolio related
to productivity applications as Microsoft has obtained its patents.

12 COMPLAINT FOR PATENT INFRINGEMENT
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41. On information and belief, Corel reviewed each published application, if one was
published, for each of the Microsoft Asserted Patents promptly upon its publication, followed up
on the application to find out if it issued as a patent, and reviewed the specification and claims of
each of the Microsoft Asserted Patents promptly upon its issuance. Alternatively, Corel was at
least willfully blind as to the existence of the Microsoft Asserted Patents.

3. Knowledge of the °828 patent

42.  Provisional application No. 60/601,815 for the 828 patent was filed on August 16,
2004. Application No. 10/955,967 was filed on September 30, 2004 and was published as U.S.
Application No. 2006/0036965 on February 16, 2006. The *828 patent issued on August 28, 2012.

43. On information and belief, Corel has had knowledge of the pending and/or
published application for the *828 patent since at least February 16, 2006 (when it was published
as Application No. 2006/0036965) and/or October 2009—March 2010 (when Microsoft
approached Corel regarding its Ribbon technology), and Corel has had knowledge of the *828
patent since at least the date of the patent issuance on August 28, 2012. Alternatively, Corel has
had knowledge of the *828 patent since at least the filing of this Complaint.

4. Knowledge of the 036 patent

44.  Provisional application No. 60/601,815 for the *036 patent was filed on August 16,
2004. Application No. 10/955,941 was filed on September 30, 2004 and was published as U.S.
Application No. 2006/0036964 on February 16, 2006. The *036 patent issued on April 20, 2010.

45. On information and belief, Corel has had knowledge of the pending and/or
published application for the 036 patent since at least February 16, 2006 (when it was published
as U.S. Application No. 2006/0036964) and/or October 2009—March 2010 (when Microsoft
approached Corel regarding its Ribbon technology), and Corel has had knowledge of the 036
patent since at least the date of the patent issuance on April 20, 2010. Alternatively, Corel has had
knowledge of the 828 patent since at least the filing of this Complaint.

5. Knowledge of the ’501 patent

46.  Corel has had knowledge of the *501 patent since at least the filing of this

Complaint.
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6. Knowledge of the ’415 patent

47.  Corel has had knowledge of the *415 patent since at least the filing of this
Complaint.

7. Knowledge of the 980 patent

48. The *980 patent issued on April 23, 1996. On information and belief, Corel has
had knowledge of Microsoft’s rights in the 980 patent since at least the date of its issuance on
April 23, 1996, and no later than 2000, when the parties had confidential interactions that cannot
be detailed in this public filing. As a result of these interactions, in 2000, Corel was aware that it
needed a license to the 980 patent for Corel’s products. Corel is also aware or should be aware
that it does not currently have a license to the *980 patent.

8. Knowledge of the D237 patent

49. The D’237 patent issued on September 4, 2007.

50. On information and belief, Corel has had knowledge of the D’237 patent since at
least September 4, 2007 (the date it issued) and/or October 2009—March 2010 (when Microsoft
approached Corel regarding its Ribbon technology). Alternatively, Corel has had knowledge of
the D’237 patent since at least the filing of this Complaint.

9. Knowledge of the D’140 patent

51.  The D’140 patent issued on October 30, 2007.

52. On information and belief, Corel has had knowledge of the D’140 patent since at
least October 30, 2007 (the date it issued) and/or October 2009—March 2010 (when Microsoft
approached Corel regarding its Ribbon technology). Alternatively, Corel has had knowledge of
the D’ 140 patent since at least the filing of this Complaint.

10. Knowledge of the D532 patent

53. The D’532 patent issued on March 18, 2008.

54. On information and belief, Corel has had knowledge of the D’532 patent since at
least March 18, 2008 (the date it issued) and/or October 2009—March 2010 (when Microsoft
approached Corel regarding its Ribbon technology). Alternatively, Corel has had knowledge of

the D’532 patent since at least the filing of this Complaint.
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11. Knowledge of the D’865 patent
55. The D’865 patent issued on June 10, 2008.
56. On information and belief, Corel has had knowledge of the D’865 patent since at
least June 10, 2008 (the date it issued) and/or October 2009—March 2010 (when Microsoft
approached Corel regarding its Ribbon technology). Alternatively, Corel has had knowledge of

the D’237 patent since at least the filing of this Complaint.

D. Corel Infringed and Continues to Infringe Each of the Microsoft Asserted

Patents
57.  Corel does not currently have a license to any of the Microsoft Asserted Patents.
58.  The allegations with respect to each asserted patent claim, each accused product,

and each specific accused feature are exemplary. Discovery has not yet begun. Microsoft

reserves the right to assert additional claims, accuse additional products, and accuse additional

features.
CLAIMS FOR RELIEF
FIRST CLAIM FOR RELIEF
Infringement of the ’828 Patent
59.  Microsoft incorporates by reference the allegations of the preceding paragraphs of

its Complaint.

60. The 828 patent is entitled “Command User Interface for Displaying Selectable
Software Functionality Controls.” A true and correct copy of the 828 patent is attached to this
Complaint as Exhibit A.

61. Corel has directly infringed and continues to infringe at least claim 1 of the *828
patent by making, using, testing, selling, licensing, offering for sale within the United States
and/or importing into the United States at least the following products: Corel Home Office,
including Corel Write, Corel Calculate, and Corel Show, and CorelCAD 2014 - 2016 (collectively
“the 828 Accused Products”).

62. The 828 Accused Products provide Ribbon menus with logically grouped controls
whose layout can be dynamically adjusted, for example as shown below:
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63.  Users of computing devices, including, for example, desktop, laptop, and tablet

computers, who use, test, sell, license, offer for sale within the United States and/or import into the
United States the 828 Accused Products on such devices, have infringed and continue to infringe
at least claim 1 of the *828 patent. Corel is and has been aware of these activities and
infringement.

64. Corel has knowingly induced and continues to induce users of computing devices
to infringe the ’828 patent, including by intentionally developing, making, marketing, advertising,
and/or providing the software, documentation, materials, training or support and aiding, abetting,
encouraging, promoting or inviting use thereof. (See, e.g.,
http://www.wordperfect.com/us/product/corel-office-software/#tab1 (promoting Corel Office
which includes Corel Write, Corel Calculate, and Corel Show); http://www.corel.com/us/free-
trials/?hptrack=mmtry (“Try Corel software for free. No risk. No obligation. No credit card
required!”); http://www.corel.com/us/support/?hptrack=mmsup (“Corel Customer Service can
assist you with orders, product registration, and any questions you may have.”);
http://learn.corel.com/?hptrack=mmlrn (“’You’ll love these tips & tutorials™).)
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65.  Corel has contributed and continues to contribute to the infringement of the 828
patent by users of computing devices, including, for example, desktop, laptop, and tablet
computers, who use, test, sell, license, offer for sale within the United States and/or import into the
United States the 828 Accused Products on such devices, by providing the software and related
documentation, materials, marketing, advertising, training or support. For example, each of the
’828 Accused Products provides Ribbon menus with logically grouped controls whose layout can
be dynamically adjusted and constitutes a material part of the invention of the *828 patent. Corel
knows and has known that this functionality is especially made or especially adapted for use in the
infringement of the 828 patent, and is not a staple article or commodity of commerce suitable for
substantial noninfringing use.

66. Corel’s infringement is and has been willful, deliberate and intentional. On
information and belief, Corel had pre-suit knowledge of the Microsoft *828 patent no later than
August 28, 2012 and deliberately copied the above-described patented functionality into its
products. To attract customers, Corel’s advertising emphasizes that Corel products mimic the
Ribbon interfaces of Microsoft products. Corel products suggest that customers simulate the look
and feel of Microsoft user interfaces. Corel has acted and continues to act in disregard of an
objectively high likelihood that its actions constituted direct and indirect infringement of a valid
patent, and knew or should have known of that objectively high risk.

SECOND CLAIM FOR RELIEF
Infringement of the 036 Patent

67.  Microsoft incorporates by reference the allegations of the preceding paragraphs of
its Complaint.

68. The *036 patent is entitled “User Interface for Displaying Selectable Software
Functionality Controls that Are Relevant to a Selected Object.” A true and correct copy of the
’036 patent is attached to this Complaint as Exhibit B.

69. Corel has directly infringed and continues to infringe at least claim 1 of the 036
patent by making, using, testing, selling, licensing, offering for sale within the United States
and/or importing into the United States at least the following products: Corel Home Office,
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including Corel Write, Corel Calculate, and Corel Show, and CorelCAD 2015 — 2016 (collectively
“the 036 Accused Products”).
70.  The ’036 Accused Products provide Ribbon menus with logically grouped controls

that provide additional controls upon selection of an object for editing, for example as shown

below:
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71.  Users of computing devices, including, for example, desktop, laptop, and tablet
computers, who use, test, sell, license, offer for sale within the United States and/or import into the
United States the 036 Accused Products on such devices, have infringed and continue to infringe
at least claim 1 of the 036 patent. Corel is and has been aware of these activities and
infringement.

72.  Corel has knowingly induced and continues to induce users of computing devices
to infringe the 036 patent, including by intentionally developing, making, marketing, advertising,
and/or providing the software, documentation, materials, training or support and aiding, abetting,
encouraging, promoting or inviting use thereof. (See, e.g.,
http://www.wordperfect.com/us/product/corel-office-software/#tab1 (promoting Corel Office
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which includes Corel Write, Corel Calculate, and Corel Show); http://www.corel.com/us/free-
trials/?hptrack=mmtry (“Try Corel software for free. No risk. No obligation. No credit card
required!”); http://www.corel.com/us/support/?hptrack=mmsup (“Corel Customer Service can
assist you with orders, product registration, and any questions you may have.”);
http://learn.corel.com/?hptrack=mmlrn (“You’ll love these tips & tutorials”).)

73. Corel has contributed and continues to contribute to the infringement of the 036
patent by users of computing devices, including, for example, desktop, laptop, and tablet
computers, who use, test, sell, license, offer for sale within the United States and/or import into the
United States the 036 Accused Products on such devices, by providing the necessary software and
related documentation, materials, marketing, advertising, training or support. For example, each
of the 036 Accused Products contains Ribbon menus with logically grouped controls that provide
additional controls upon selection of an object for editing and constitutes a material part of the
invention of the *036 patent. Corel knows and has known that this functionality is especially made
or especially adapted for use in the infringement of the *036 patent, and is not a staple article or
commodity of commerce suitable for substantial noninfringing use.

74. Corel’s infringement is and has been willful, deliberate and intentional. On
information and belief, Corel had pre-suit knowledge of the Microsoft *036 patent since at least
October 2009—March 2010 and no later than April 20, 2010 and deliberately copied the above-
described patented functionality into its products. To attract customers, Corel’s advertising
emphasizes that Corel products mimic the Ribbon interfaces of Microsoft products. Corel
products suggest that customers simulate the look and feel of Microsoft user interfaces. Corel has
acted and continues to act in disregard of an objectively high likelihood that its actions constituted

direct and indirect infringement of a valid patent, and knew or should have known of that

objectively high risk.
THIRD CLAIM FOR RELIEF
Infringement of the 501 Patent
75.  Microsoft incorporates by reference the allegations of the preceding paragraphs of

its Complaint.
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76.

The *501 patent is entitled “Method for Displaying Controls in a System Using a

Graphical User Interface.” A true and correct copy of the *501 patent is attached to this Complaint

as Exhibit C.
77.

Corel has directly infringed and continues to infringe at least claim 9 of the *501

patent by making, using, testing, selling, licensing, offering for sale within the United States

and/or importing into the United States at least the following products: Corel Home Office,

including Corel Write, Corel Calculate, and Corel Show; CoreDRAW X7; and WordPerfect

Office X5 and X7, including WordPerfect X5 and X7, Quattro Pro X5 and X7, and Presentations

X5 and X7 (collectively “the 501 Accused Products”).

78.  The ’501 Accused Products allow the user to customize a command bar by

dragging and dropping controls from a list, for example as shown below:
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79.  Users of computing devices, including, for example, desktop, laptop, and tablet
computers, who use, test, sell, license, offer for sale within the United States and/or import into the
United States the *501 Accused Products on such devices, have infringed and continue to infringe
at least claim 9 of the *501 patent. Corel is and has been aware of these activities and
infringement since at least the filing of this Complaint.

80.  Corel induces users of computing devices to infringe the 501 patent, including by
intentionally developing, making, marketing, advertising, and/or providing the software,
documentation, materials, training or support and aiding, abetting, encouraging, promoting or
inviting use thereof. (See, e.g., http://www.wordperfect.com/us/product/corel-office-
software/#tabl (promoting Corel Office which includes Corel Write, Corel Calculate, and Corel
Show); http://www.corel.com/us/free-trials/?hptrack=mmtry (“Try Corel software for free. No
risk. No obligation. No credit card required!”); http://www.corel.com/us/support/?hptrack=mmsup
(“Corel Customer Service can assist you with orders, product registration, and any questions you
may have.”); http://learn.corel.com/?hptrack=mmlrn (“You’ll love these tips & tutorials”).)

81. Corel contributes to the infringement of the 501 patent by users of computing
devices, including, for example, desktop, laptop, and tablet computers, who use, test, sell, license,
offer for sale within the United States and/or import into the United States the 501 Accused
Products on such devices, by providing the necessary software and related documentation,
materials, marketing, advertising, training or support. For example, each of the *501 Accused
Products allows to customize a command bar by dragging and dropping controls from a list and
constitutes a material part of the invention of the *501 patent. Corel knows that this functionality
is especially made or especially adapted for use in the infringement of the *501 patent, and is not a
staple article or commodity of commerce suitable for substantial noninfringing use.

FOURTH CLAIM FOR RELIEF
Infringement of the ’415 Patent

82.  Microsoft incorporates by reference the allegations of the preceding paragraphs of
its Complaint.

83. The ’415 patent is entitled “Computer Application with Help Pane Integrated into
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Workspace.” A true and correct copy of the *415 patent is attached to this Complaint as Exhibit D.

84. Corel has directly infringed and continues to infringe at least claims 1-2, 8, and 10
of the ’415 patent by making, using, testing, selling, licensing, offering for sale within the United
States and/or importing into the United States at least the following products: Word Perfect X5
and X7.

85. Corel has directly infringed and continues to infringe at least claims 1-3, 8, and 10
of the ’415 patent by making, using, testing, selling, licensing, offering for sale within the United
States and/or importing into the United States at least the following products: CoreIDRAW X7.

86. Corel has directly infringed and continues to infringe at least claim 3 of the *415
patent by making, using, testing, selling, licensing, offering for sale within the United States
and/or importing into the United States at least the following products: Presentations X7.

87. The above-listed products meeting the above-listed claims of the *415 patent are
hereinafter collectively referred to as “the 415 Accused Products.”

88.  The 415 Accused Products display help content in a pane that is part of the
application window and does not take the focus away from the window, for example as shown

below:
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89.  Users of computing devices, including, for example, desktop, laptop, and tablet
computers, who use, test, sell, license, offer for sale within the United States and/or import into the
United States the 415 Accused Products on such devices, have infringed and continue to infringe
at least claims 1-3, 8, and 10 of the 415 patent. Corel is and has been aware of these activities
and infringement since at least the filing of this Complaint.

90.  Corel induces users of computing devices to infringe the *415 patent, including by
intentionally developing, making, marketing, advertising, and/or providing the software,
documentation, materials, training or support and aiding, abetting, encouraging, promoting or
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inviting use thereof. (See, e.g., http://www.corel.com/us/free-trials/?hptrack=mmtry (“Try Corel
software for free. No risk. No obligation. No credit card required!”);
http://www.corel.com/us/support/?hptrack=mmsup (“Corel Customer Service can assist you with
orders, product registration, and any questions you may have.”);
http://learn.corel.com/?hptrack=mmlrn (“’You’ll love these tips & tutorials”).)

91. Corel contributes to the infringement of the *415 patent by users of computing
devices, including, for example, desktop, laptop, and tablet computers, who use, test, sell, license,
offer for sale within the United States and/or import into the United States the 415 Accused
Products on such devices, by providing the necessary software and related documentation,
materials, marketing, advertising, training or support. For example, each of the 415 Accused
Products displays help content in a pane that is part of the application window without taking the
focus away from the window, and constitutes a material part of the invention of the 415 patent.
Corel knows that this functionality is especially made or especially adapted for use in the
infringement of the 415 patent, and is not a staple article or commodity of commerce suitable for
substantial noninfringing use.

FIFTH CLAIM FOR RELIEF
Infringement of the 980 Patent

92.  Microsoft incorporates by reference the allegations of the preceding paragraphs of
its Complaint.

93.  The ’980 patent is entitled “Method and System for Selecting and Executing
Arithmetic Functions and the Like.” A true and correct copy of the *980 patent is attached to this
Complaint as Exhibit E.

94. Corel has directly infringed at least claim 1 of the 980 patent by making, using,
testing, selling, licensing, offering for sale within the United States and/or importing into the
United States at least the following products: Quattro Pro X5 and Corel Calculate (“the 980
Accused Products™).

95.  The *980 Accused Products allow the software to automatically select cells in a

spreadsheet to perform a sum function, for example as shown below:
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96.  Users of computing devices, including, for example, desktop, laptop, and tablet

computers, who use, test, sell, license, offer for sale within the United States and/or import into the
United States the 980 Accused Products on such devices, have infringed at least claim 1 of the
’980 patent. Corel is and has been aware of these activities and infringement.

97. Corel has knowingly induced users of computing devices to infringe the *980
patent, including by intentionally developing, making, marketing, advertising, and/or providing
the software, documentation, materials, training or support and aiding, abetting, encouraging,
promoting or inviting use thereof. (See, e.g.,
http://www.wordperfect.com/static/landing_pages/16900020/QP_2.pdf (“Quattro Pro offers over
500 functions: built-in calculations that you can use within—or instead of—math formulas.”);
http://www.corel.com/us/free-trials/?hptrack=mmtry (“Try Corel software for free. No risk. No

'9’

obligation. No credit card required!”); http://www.corel.com/us/support/?hptrack=mmsup (“Corel
Customer Service can assist you with orders, product registration, and any questions you may
have.”); http://learn.corel.com/?hptrack=mmlrn (“’You’ll love these tips & tutorials™).)
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98.  Corel has contributed to the infringement of the 980 patent by users of computing
devices, including, for example, desktop, laptop, and tablet computers, who use, test, sell, license,
offer for sale within the United States and/or import into the United States the 980 Accused
Products on such devices, by providing the necessary software and related documentation,
materials, marketing, advertising, training or support. For example, each of the *980 Accused
Products allows to automatically select cells in a spreadsheet to perform a sum function and
constitutes a material part of the invention of the *980 patent. Corel knows that this functionality
is especially made or especially adapted for use in the infringement of the 980 patent, and is not a
staple article or commodity of commerce suitable for substantial noninfringing use.

99. Corel’s infringement has been willful, deliberate and intentional. On information
and belief, Corel had pre-suit knowledge of the Microsoft 980 patent no later than 2000 and
deliberately copied the above-described patented functionality into its products. To attract
customers, Corel’s advertising emphasizes that Corel products mimic the graphic user interfaces
of Microsoft products. Corel products suggest that customers simulate the look and feel of
Microsoft user interfaces. Corel has acted in disregard of an objectively high likelihood that its
actions constituted direct and indirect infringement of a valid patent, and knew or should have
known of that objectively high risk.

SIXTH CLAIM FOR RELIEF
Infringement of the D237 patent

100.  Microsoft incorporates by reference the allegations of the preceding paragraphs of
its Complaint.

101. The D’237 patent is entitled “User Interface for a Portion of a Display Screen.” A
true and correct copy of the D’237 patent is attached to this Complaint as Exhibit F.

102.  Corel has directly infringed and continues to infringe the D237 patent by making,
using, testing, selling, licensing, offering for sale within the United States and/or importing into
the United States at least the following products: Corel Home Office, including Corel Write,

Corel Calculate, and Corel Show (collectively “the D’237 Accused Products”™), that incorporate a
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user interface for a portion of a display screen identical to the D’237 patented design, for example

as shown below:
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103.  Users of computing devices, including, for example, desktop, laptop, and tablet
computers, who use, test, sell, license, offer for sale within the United States and/or import into the
United States the D’237 Accused Products on such devices, have infringed and continue to
infringe the D’237 patent. Corel is and has been aware of these activities and infringement.

104.  Corel has knowingly induced and continues to induce users of computing devices
to infringe the D’237 patent, including by intentionally developing, making, marketing,
advertising, and/or providing the software, documentation, materials, training or support and
aiding, abetting, encouraging, promoting or inviting use thereof. (See, e.g.,
http://www.wordperfect.com/us/product/corel-office-software/#tabl (promoting Corel Office
which includes Corel Write, Corel Calculate, and Corel Show); http://www.corel.com/us/free-
trials/?hptrack=mmtry (“Try Corel software for free. No risk. No obligation. No credit card
required!”); http://www.corel.com/us/support/?hptrack=mmsup (“Corel Customer Service can
assist you with orders, product registration, and any questions you may have.”);
http://learn.corel.com/?hptrack=mmlrn (“You’ll love these tips & tutorials”).)

105.  Corel has contributed and continues to contribute to the infringement of the D’237
patent by users of computing devices, including, for example, desktop, laptop, and tablet
computers, who use, test, sell, license, offer for sale within the United States and/or import into the
United States the D’237 Accused Products on such devices, by providing the necessary software
and related documentation, materials, marketing, advertising, training or support. For example,
the above-shown design included in the D’237 Accused Products is a material component of the
patented design. Corel knows and has known that this design is especially made or especially
adapted for use in the infringement of the D237 patent, and is not a staple article or commodity of
commerce suitable for substantial noninfringing use.

106.  Corel’s infringement is and has been willful, deliberate and intentional. On
information and belief, Corel had pre-suit knowledge of the Microsoft D’237 patent no later than
October 2009—March 2010 and deliberately copied the above-described patented functionality
into its products. To attract customers, Corel’s advertising emphasizes that Corel products mimic
the Ribbon interfaces of Microsoft products. Corel products suggest that customers simulate the
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look and feel of Microsoft user interfaces. Corel has acted and continues to act in disregard of an
objectively high likelihood that its actions constituted direct and indirect infringement of a valid
patent, and knew or should have known of that objectively high risk.
SEVENTH CLAIM FOR RELIEF
Infringement of the D’140 Patent

107.  Microsoft incorporates by reference the allegations of the preceding paragraphs of
its Complaint.

108.  The D’140 patent is entitled “User Interface for a Portion of a Display Screen.” A
true and correct copy of the D’140 patent is attached to this Complaint as Exhibit G.

109.  Corel has directly infringed and continues to infringe the D’140 patent by making,
using, testing, selling, licensing, offering for sale within the United States and/or importing into
the United States at least the following products: Corel Home Office, including Corel Write,
Corel Calculate, and Corel Show (collectively “the D’140 Accused Products”), that incorporate a
user interface for a portion of a display screen identical to the D’140 patented design, for example

as shown below:

The D140 patent
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110.  Users of computing devices, including, for example, desktop, laptop, and tablet
computers, who use, test, sell, license, offer for sale within the United States and/or import into the
United States the D’140 Accused Products on such devices, have infringed and continue to
infringe the D’140 patent. Corel is and has been aware of these activities and infringement.

111.  Corel has knowingly induced and continues to induce users of computing devices
to infringe the D’ 140 patent, including by intentionally developing, making, marketing,
advertising, and/or providing the software, documentation, materials, training or support and
aiding, abetting, encouraging, promoting or inviting use thereof. (See, e.g.,
http://www.wordperfect.com/us/product/corel-office-software/#tabl (promoting Corel Office
which includes Corel Write, Corel Calculate, and Corel Show); http://www.corel.com/us/free-
trials/?hptrack=mmtry (“Try Corel software for free. No risk. No obligation. No credit card
required!”); http://www.corel.com/us/support/?hptrack=mmsup (“Corel Customer Service can
assist you with orders, product registration, and any questions you may have.”);
http://learn.corel.com/?hptrack=mmlrn (“You’ll love these tips & tutorials”).)

112.  Corel has contributed and continues to contribute to the infringement of the D’140
patent by users of computing devices, including, for example, desktop, laptop, and tablet
computers, who use, test, sell, license, offer for sale within the United States and/or import into the
United States the D’140 Accused Products on such devices, by providing the necessary software
and related documentation, materials, marketing, advertising, training or support. For example,
the above-shown design included in the D’140 Accused Products is a material component of the
patented design. Corel knows and has known that this design is especially made or especially
adapted for use in the infringement of the D’ 140 patent, and is not a staple article or commodity of
commerce suitable for substantial noninfringing use.

113.  Corel’s infringement is and has been willful, deliberate and intentional. On
information and belief, Corel had pre-suit knowledge of the Microsoft D’ 140 patent no later than
October 2009—March 2010 and deliberately copied the above-described patented functionality
into its products. To attract customers, Corel’s advertising emphasizes that Corel products mimic
the Ribbon interfaces of Microsoft products. Corel products suggest that customers simulate the

31 COMPLAINT FOR PATENT INFRINGEMENT




10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28

Case 5:15-cv-05836 Document 1 Filed 12/18/15 Page 33 of 39

look and feel of Microsoft user interfaces. Corel has acted and continues to act in disregard of an
objectively high likelihood that its actions constituted direct and indirect infringement of a valid
patent, and knew or should have known of that objectively high risk.

EIGHTH CLAIM FOR RELIEF

Infringement of the D532 Patent

114.  Microsoft incorporates by reference the allegations of the preceding paragraphs of
its Complaint.

115.  The D’532 patent is entitled “User Interface for a Portion of a Display Screen.” A
true and correct copy of the D532 patent is attached to this Complaint as Exhibit H.

116.  Corel has directly infringed and continues to infringe the D’532 patent by making,
using, testing, selling, licensing, offering for sale within the United States and/or importing into
the United States at least the following product: CorelCAD 2014 - 2016 (collectively “the D’532
Accused Products”), that incorporates a user interface for a portion of a display screen identical to

the D’532 patented design, for example as shown below:

The D’532 patent
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117.  Users of computing devices, including, for example, desktop, laptop, and tablet
computers, who use, test, sell, license, offer for sale within the United States and/or import into the
United States the D’532 Accused Products on such devices, have infringed and continue to
infringe the D’532 patent. Corel is and has been aware of these activities and infringement.

118.  Corel has knowingly induced and continues to induce users of computing devices
to infringe the D’532 patent, including by intentionally developing, making, marketing,
advertising, and/or providing the software, documentation, materials, training or support and
aiding, abetting, encouraging, promoting or inviting use thereof. (See, e.g.,
http://www.coreldraw.com/us/product/cad-software/?&gclid=CIOBja6wv8kCFSISfgod]J9IMJRA
(promoting Corel CAD); http://www.corel.com/us/free-trials/?hptrack=mmtry (“Try Corel
software for free. No risk. No obligation. No credit card required!”);
http://www.corel.com/us/support/?hptrack=mmsup (“Corel Customer Service can assist you with
orders, product registration, and any questions you may have.”);
http://learn.corel.com/?hptrack=mmlrn (“You’ll love these tips & tutorials”).)

119.  Corel has contributed and continues to contribute to the infringement of the D’532
patent by users of computing devices, including, for example, desktop, laptop, and tablet
computers, who use, test, sell, license, offer for sale within the United States and/or import into the
United States the D’532 Accused Products on such devices, by providing the necessary software
and related documentation, materials, marketing, advertising, training or support. For example,
the above-shown design included in the D’532 Accused Products is a material component of the
patented design. Corel knows and has known that this design is especially made or especially
adapted for use in the infringement of the D’532 patent, and is not a staple article or commodity of
commerce suitable for substantial noninfringing use.

120.  Corel’s infringement is and has been willful, deliberate and intentional. On
information and belief, Corel had pre-suit knowledge of the Microsoft D’532 patent no later than
October 2009—March 2010 and deliberately copied the above-described patented functionality
into its products. To attract customers, Corel’s advertising emphasizes that Corel products mimic
the Ribbon interfaces of Microsoft products. Corel products suggest that customers simulate the
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look and feel of Microsoft user interfaces. Corel has acted and continues to act in disregard of an
objectively high likelihood that its actions constituted direct and indirect infringement of a valid
patent, and knew or should have known of that objectively high risk.
NINTH CLAIM FOR RELIEF
Infringement of the D’865 Patent

121.  Microsoft incorporates by reference the allegations of the preceding paragraphs of
its Complaint.

122.  The D’865 patent is entitled “User Interface for a Portion of a Display Screen.” A
true and correct copy of the D’865 patent is attached to this Complaint as Exhibit I.

123.  Corel has directly infringed and continues to infringe the D’865 patent by making,
using, testing, selling, licensing, offering for sale within the United States and/or importing into
the United States at least the following product: Corel Home Office, including Corel Write, Corel
Calculate, and Corel Show (“the D’865 Accused Products”), that incorporates a user interface for

a portion of a display screen identical to the D’865 patented design, for example as shown below:

The D’865 patent
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124.  Users of computing devices, including, for example, desktop, laptop, and tablet

computers, who use, test, sell, license, offer for sale within the United States and/or import into the
United States the D’865 Accused Products on such devices, have infringed and continue to

infringe the D’865 patent. Corel is and has been aware of these activities and infringement.
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125.  Corel has knowingly induced and continues to induce users of computing devices
to infringe the D’865 patent, including by intentionally developing, making, marketing,
advertising, and/or providing the software, documentation, materials, training or support and
aiding, abetting, encouraging, promoting or inviting use thereof. (See, e.g.,
http://www.wordperfect.com/us/product/corel-office-software/#tab1 (promoting Corel Office
which includes Corel Show); http://www.corel.com/us/free-trials/?hptrack=mmtry (“Try Corel
software for free. No risk. No obligation. No credit card required!”);
http://www.corel.com/us/support/?hptrack=mmsup (“Corel Customer Service can assist you with
orders, product registration, and any questions you may have.”);
http://learn.corel.com/?hptrack=mmlrn (“’You’ll love these tips & tutorials”).)

126.  Corel has contributed and continues to contribute to the infringement of the D’865
patent by users of computing devices, including, for example, desktop, laptop, and tablet
computers, who use, test, sell, license, offer for sale within the United States and/or import into the
United States the D’865 Accused Products on such devices, by providing the necessary software
and related documentation, materials, marketing, advertising, training or support. For example,
the above-shown design included in the D’865 Accused Products is a material component of the
patented design. Corel knows and has known that this design is especially made or especially
adapted for use in the infringement of the D’865 patent, and is not a staple article or commodity of
commerce suitable for substantial noninfringing use.

127.  Corel’s infringement is and has been willful, deliberate and intentional. On
information and belief, Corel had pre-suit knowledge of the Microsoft D’865 patent no later than
October 2009—March 2010 and deliberately copied the above-described patented functionality
into its products. To attract customers, Corel’s advertising emphasizes that Corel products mimic
the Ribbon interfaces of Microsoft products. Corel products suggest that customers simulate the
look and feel of Microsoft user interfaces. Corel has acted and continues to act in disregard of an
objectively high likelihood that its actions constituted direct and indirect infringement of a valid

patent, and knew or should have known of that objectively high risk.
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E. Corel’s Infringement Has Caused and Will Continue to Cause Injury to
Microsoft

128.  Corel’s infringement of each of the Microsoft Asserted Patents as pleaded above
has caused injury to Microsoft in the past and will continue to cause injury in the future.

129.  Microsoft is entitled to recover damages adequate to compensate for Corel’s
infringement, in an amount to be determined at trial. Such damages shall be in no event less than
a reasonable royalty and should include lost profits and/or disgorgement of profits, to the extent
permitted by law.

PRAYER FOR RELIEF

WHEREFORE, Microsoft prays that this Court enter judgment and provide relief as
follows:

(a) That Corel has directly infringed the Microsoft Asserted Patents;

(b) That Corel has induced infringement of the Microsoft Asserted Patents;

(©) That Corel has contributed to the infringement of the Microsoft Asserted Patents;

(d) That Corel has willfully infringed the 828, *036, *980, D°237, D’140, D’532, and
D’865 Microsoft Asserted Patents;

(e) That Corel be ordered to account for and pay to Microsoft the damages resulting
from Corel’s infringement of the Microsoft Asserted Patents, together with interest and costs, and
all other damages permitted by 35 U.S.C. §§ 284 and/or 289, including enhanced damages up to
three times the amount of damages found or measured, and further including an accounting for
infringing sales not presented at trial and an award by the court of additional damages for any such
infringing sales;

® That this case, including Corel’s prosecution of its claims, be declared exceptional
and Microsoft be awarded its costs, expenses, and reasonable attorneys’ fees in this action
pursuant to 35 U.S.C. § 285; and

(2) That Microsoft be awarded such other equitable or legal relief as this Court deems

just and proper under the circumstances.
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DEMAND FOR JURY TRIAL
Pursuant to Federal Rule of Civil Procedure 38, Microsoft demands a jury trial on all issues

so triable.

Dated: December 18, 2015 FISH & RICHARDSON P.C.

By: /s/Olga I. May

Frank Scherkenbach (CA SBN 142549)
scherkenbach@fr.com

FISH & RICHARDSON P.C.

One Marina Park Drive

Boston, MA 02210-1878

Telephone: (617) 542-5070

Facsimile: (617) 542-8906

Jonathan J. Lamberson (SBN 239107)
lamberson@fr.com

FISH & RICHARDSON P.C.

500 Arguello Street, Suite 500
Redwood City, CA 94063

Telephone: (650) 839-5070
Facsimile: (650) 839-5071

John W. Thornburgh (CA SBN 154627)
thornburgh@fr.com

Olga I. May (CA SBN 232012)
omay@fr.com

FISH & RICHARDSON P.C.

12390 El Camino Real

San Diego, CA 92130

Telephone: (858) 678-5070

Facsimile: (858) 678-5099

Attorneys for Plaintiff Microsoft Corporation
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